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Introduction 

This document is a supplement to the online Reference Manual. It describes how to use 
MCID™ Elite to quantify radiolabeled tissue sections that have been exposed to 
autoradiographic film or phosphor plates. When images are calibrated appropriately, data 
may be expressed in isotope concentrations (e.g., nCi/mg tissue wt.) or ligand 
concentrations (e.g., fmol/mg tissue wt.). 

Please note that MCID Elite also includes a specialized ‘Study Type’ for receptor binding 
studies. When enabled, it allows simultaneous sampling of Total Binding and Nonspecific 
Binding specimens, and automatically calculates a ‘Specific Binding’ and ‘% Specific 
Binding’ value. If you are performing these kinds of studies, please refer to the Receptor 
Binding Application Guide for instructions. Refer to the current document as a general 
guide to quantitative autoradiography. 

Separate Application Guides are also available that describe how to use MCID Elite to 
measure rates of glucose metabolism, protein synthesis, or blood flow from 
autoradiographic images. Any of these Application Guides can be downloaded from our 
web site, at http://www.imagingresearch.com/documentation.  If your MCID Elite 
computer is connected to the Internet, simply select Help > Manuals web site to connect. 

Basic Procedure 
The basic procedure for quantifying autoradiographic images is as follows: 

1. Adjust camera magnification and focus. 

2. Establish a Flat Field Correction to correct for uneven illumination. 

3. Establish a density calibration. 

4. Sample any/all specimens on the same film/plate as the density standards. 

5. Repeat Steps 3-4 for all remaining films/plates. 

6. Summarize and save the data. 

If you are working with phosphor plate images, Steps 1-2 do not apply. 

Step 1: Adjust Magnification and Focus 

Magnification is controlled by moving the camera up or down. Place a sheet of film on the 
light box and adjust the camera height while digitizing. With a 55mm lens, you should be 
able move the camera close enough so that a coronal rat brain section will almost fill the 
entire field of view. If the camera is too close to the specimen, you will not be able 
generate a clearly focused image. 

If higher magnification is required (e.g., for mouse brain or spinal cord sections), use 
extension tubes. Extension tubes are little barrels that connect between the lens and the F-
C adapter.  They function like a bellows to increase magnification of the lens.  Various 
sizes of extension tube give different magnification factors.  For example, coronal section 
of spinal cord can be made to fill the screen when all three tubes are used. 

http://www.imagingresearch.com/documentation
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Step 2: Establish a Flat Field Correction 

Camera images typically exhibit some intensity variation over the field of view due to 
uneven illumination.  This “shading error” requires correction to less than 1% if accurate 
densitometry is to be performed. The Flat Field Correction compensates for shading 
error. 

TO ESTABLISH A FLAT FIELD CORRECTION: 
1. Remove the film from the field of view. 

2. Select a pseudocolor look-up table (i.e., SPECT2.VIS) 

3. Adjust the illumination intensity on the light box so that a blank field of view 
appears bluish-pink. Be sure to use a true blank field, not film background! 

4. Ctrl-click on the Digitize icon and select Flat Field Correction from the list of 
Input Device Operations.  If the operation is not present, click the [Customize] 
button to add it to the list. 

5. A Flat Field Correction dialog box will appear (Figure 1). An [Acquire] and 
[Clear] button are displayed at the bottom of the dialog box, but only one of them 
will be active. If the [Clear] button is active, it means that a flat field correction is 
already in effect. Press [Clear] to remove it. 

6. Select Digitize as the correction source and Pixel by pixel as the correction 
method. 

7. The Frame average option will reduce the contribution of random electronic 
noise to the shading error.  Three or four will usually do, unless you disable the 
Smoothing and Median filters (see below). 

8. By default, a Smoothing and Median filter is applied to the shading error 
reference image (i.e., the blank field image) to reduce spatial variation and 
improve the signal-to-noise ratio. If you choose to disable these filters, be sure to 
use the Frame Averaging option when establishing the flat field correction, and 
increase the number of frames to 16 or more. 

9. Press [Acquire] to establish a flat field correction.  

10. MCID Elite scans the blank field and determines how much each pixel deviates 
from the mean gray level value.  Subsequent images are automatically corrected 
for uneven illumination, based on this error pattern. 

11. Click [OK] to exit the dialog box. 

Please note, the image that you see after you exit the dialog box is not a corrected image. 
The Flat Field Correction is not applied until the next time you digitize. If you wish to 
see the effects of the correction, digitize the same blank field again. The image will ‘even 
out’ as soon as digitization is terminated. 

Once established, the flat field correction becomes part of the camera’s default 
configuration. Unless disabled or modified, MCID Elite will apply the same correction 
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each time the particular camera is used, even if you have exited and re-started MCID 
Elite. As such, you should establish a new Flat Field Correction at the beginning of each 
analysis session. 

One should also re-establish a Flat Field Correction whenever there is a change in 
ambient lighting, camera position, focus, camera gain and offset, light box position, or any 
other major factor that might affect the illumination pattern.  Small changes in 
illumination level do not usually need a new correction, however, providing that optical 
system components are not moved relative to each other. 

To remove or modify the current flat field correction, click the [Clear] button on the Flat 
Field Correction dialog box. Press [Acquire] to establish a new one. 

Figure 1: The Flat Field Correction dialog box. 

 

Step 3: Establish a Density Calibration 

To express autoradiographic data in units of isotope or ligand concentration, you must co-
expose a set of isotope concentration standards (e.g., Amersham™ Microscales™) with 
your tissue sections. A standard curve is then constructed, that relates the system’s internal 
density measurement units (e.g., ROD, PSL/mm2) to the standard values. This is achieved 
by entering the standard values into a calibration table and reading the density of each 
corresponding standard.   As each standard is sampled, MCID Elite plots the standard 
curve (density vs standard value) next to the calibration table.  The standard curve should 
span the entire range of densities found in the specimens under study. At least one set of 
standards should be also present on each film or phosphor plate.  
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For film autoradiography, the general procedure is as follows: 

1. Digitize the standards.  Adjust the illumination level so that film background 
appears pinkish-blue with the SPECTRAL.VIS or SPECT2.VIS look-up table.  
This step ensures that you are maximizing the dynamic range of the system. 

2. Construct a calibration curve.  Enter the standard values into the calibration table 
and sample the standards. 

3. Select a curve fitting function. 

4. Select an extrapolation function.  This step tells MCID Elite what to do with 
pixels that are outside the range of calibration values. 

For phosphor plate autoradiography, Step 1 is unnecessary. 

Building the Calibration Table 
Click the Calibration icon to open the Calibration operational window: 

 

Open the Establish menu and select the Density option. Change the density unit to Cal 
stds.  A dialog box now appears, asking you to select a density standards file (Figure 2).  
To load a file from disk, select the file and click on [OK].  If you want to type the values 
into the calibration table, click on [None].  To create a standards file, click on [Create] 
(see the Advanced Details section for instructions). 

Figure 2: When you select a calibrated density unit (e.g., Cal stds), MCID Elite asks for a 
file that contains the values of the external standards. 

 

Entering the Standard Values 
When you click on [OK] to leave the Open Density Standards File dialog box, the 
Calibration window appears as it does in Figure 3.  On the left side of the window is a 
table with four columns labeled Std #, Std Value, Value Read, and Rel Error.  Just 
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above the table are two entry fields, one for the Standards unit and one for Value read 
unit.  To the right of the table is the region where the calibration curve (e.g., ROD vs 
standard value) will be plotted. 

If you are using a density standards file, the standard values are displayed in the Std Value 
column.  Otherwise, type the values of the standards into this column and enter the 
appropriate concentration units (e.g., nCi/g, fmol/mg) into the Standards unit entry field.  
We recommend using a “0” as the lowest concentration standard.  When you have entered 
all of the standard values, click the cursor in the Value Read column next to the first 
standard value. 

Note: When entering the standard values, make sure you use ‘tissue equivalent’ 
values and that they are appropriate for the thickness of your tissue sections. 

Figure 3: The Calibration window. 

 

Sampling the Standards 
Select a pseudocolor look-up table (SPECTRAL.VIS or SPECT2.VIS) and digitize the 
standards.  A pseudocolor display makes it easier to see the appropriate light intensity 
settings for background and standards.   It is important to optimize the lighting of your 
specimen.  Optimal lighting varies with film density but, ideally, there is a range of less 
than 1 ROD between the darkest and the lightest areas of the film.  In this case, blank film 
would read about .05 ROD in an 8-bit image (appears pinkish blue in the pseudocolor 
image), while the darkest areas of the autoradiograph read about 0.9 ROD (appear dark 
red).  Do not read from film areas that are so light that MCID Elite sees a maximum light 

CALIBRATION 
CURVE AREA  

CALIBRATION 
TABLE 
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value (white).  If the film background is pink with many white speckles (saturated pixels), 
turn down the illumination a bit. 

Note: Small changes in illumination level do not usually require a new Flat Field 
Correction, providing that optical system components are not moved relative 
to each other.  

The lightest standard should be a film background reading, entered as a zero concentration 
in the Std Value column.  The darkest standard read should lie within a fairly linear 
region of film response.  Starting with the lightest standard, sample each one in order of 
ascending concentration.  Re-digitize and re-position the standards as needed (do not 
change the camera height).  Use the Box sample tool, and adjust its size so that it fits just 
within the edges of the standard.  As each standard is sampled, its density value appears in 
the calibration table in the Value Read column, and the entry field automatically shifts to 
the next position on the list.  A calibration curve is plotted to the right of the calibration 
table (Figure 4). 

If you are calibrating a phosphor plate image, simply sample the standards in the order that 
they appear in the calibration table. The lightest standard should be a plate background 
reading, entered as a “0” concentration in the Std Value column. 

Figure 4: A completed density calibration. 

 

Curve Fitting 
Once you have constructed the calibration table, you need to fit a curve to your data 
points.  Use the Curve type option to select an interpolation or approximation function 
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that calculates density values that lie between the steps provided by the calibration 
reference (Figure 5).  

The graph shows how well a selected fitting function fits the concentration values of the 
reference.  A numerical estimate of goodness of fit is available from the Rel Error 
column in the calibration table, where: 

Relative Error  =  (standard value - curve value) / standard value 

With any good fit, the error proportions will be low (< 0.1). 

Experiment with all of the fitting functions.  If you are using highly linear devices, such as 
phosphor imagers, you may prefer one of the linear regression models.  Our own favorite 
for both linear and non-linear scanners is the smoothed spline, which offers significant 
advantages relative to the unsmoothed spline.  The unsmoothed spline is a cube root 
function that goes through all the points. Because it accommodates to standards that do not 
fit a cube root polynomial, the unsmoothed spline may contain abrupt changes in slope.  
Smoothing the spline allows it to deviate from all of the points, except for the lightest 
density reference (the X,Y origin of the calibration).  The smoothed spline is forced 
through the lightest reference. 

Figure 5: Interpolation or approximation functions are used to calculate concentration 
values that lie between those contained in the standard set. 

 

Extrapolation Functions 
By default, MCID Elite extrapolates calibrated values for pixels that are out of range (i.e., 
that do not fall within the calibration curve). A variety of extrapolation functions are 
available, and they can be applied to either end of the calibration curve. Click on the 
[Extrapolate] button located at the bottom of the calibration . This displays the 
Extrapolation dialog box, in which you can either select different forms of extrapolation 
or turn it off (i.e., clip pixel values to the minimum or maximum standard value). 



MCID Elite Application Guide  Quantitative Autoradiography  8 

01-MW-0191 Imaging Research Inc. 

Figure 6: Density values beyond the range of standard values are estimated by 
extrapolation of the standard curve.  You can apply different functions to the maximum 
and minimum ends of the curve. 

 

Validity of Density Calibrations 
Density calibrations are valid only under a very narrow range of conditions.  ROD values, 
for example, will fluctuate in response to changes in illumination, lens aperture settings, 
camera height, camera settings (gain, offset, exposure time) and even to changes in 
ambient lighting conditions.  ROD values will also fluctuate from one sheet of film to the 
next.  A density calibration is valid for any specimen that was exposed on the same sheet 
of film as the reference scale and imaged under the same optical conditions that were in 
effect when you established the calibration curve.  Re-calibration is necessary whenever 
any of these conditions change. 

If you are calibrating phosphor plate images, density calibrations are valid for any 
specimen that was exposed on the same plate as the reference scale. 

Step 4: Sample the Specimen 

To gather density data, move to the Sample operation window, select a Sample tool, and 
click it on the image.  See the online Reference Manual (Chapter 3: Collecting Data) for 
complete descriptions of Sample tools and instructions for their use. 

If necessary, use Visuals controls to make features of interest more visible when sampling. 
You can change the way an image looks by selecting a different look-up table (LUT), by 
enhancing contrast, or by changing the LUT mapping function. Although these Visuals 
manipulations change the way an image looks, please remember that none of them change 
the actual density values of the image pixels. See the online Reference Manual for details 
(Chapter 12: Altering Image Appearance). 
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Calculating the Density Value 
Density data are reported in the data table in calibrated units. MCID Elite calculates the 
density value of a sample by first calibrating each pixel and then taking the mean of the 
calibrated pixel values.  This is called “integrated optical density”, or IOD: 

Integrated Optical Density = Sum of the calibrated pixel values / number of pixels 

This is the most accurate way to calculate density values and is appropriate whether you 
are working with internally calibrated units (e.g., phosphor plate imagers) or with 
calibrations to external density standards. 

When Density Data are Displayed in Red 
Occasionally, calibrated density data may be “flagged” in red.  This means that some of 
the pixels in the sample have density values that do not fall within the range of values 
established for the calibration curve. See the Advanced Details section for more 
information. 

Labeling Data 
MCID Elite organizes data in a hierarchical fashion as they are gathered: 

Subject Animal/subject used in study.  

Section Tissue section from subject.  

Region Anatomical region within tissue section (e.g., “thalamus”, “cortex-left”) 

Target Area of an image sampled under a discrete Region label.  A target is 
outlined or defined by a Sample tool. 

Enter the appropriate Subject, Section and Region labels as you gather data. “Targets” are 
numbered automatically. 

TO CREATE LABELS: 
1. Click on one of the Subject, Section or Region headings.  A label dialog box 

appears on the screen. Each label type has a specific dialog box. 

2. Enter the Subject (optional), Section (optional) and Region label in the entry 
field of the relevant dialog box. 

3. Sample the region corresponding to this label.   

4. Enter a new Region label and continue until you have all read regions in the 
section. 

5. Repeat steps 2 - 4, updating the subject and section labels as required.  

6. Click on the [Done] buttons to close the dialog boxes. 

Figure 7: The basic set of labels for managing data from sectioned specimens. 
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For more information, see Chapter 10: Data Management in the online Reference 
Manual. 

Redirected Sampling 
Anatomical landmarks are often difficult to visualize in autographic images, or they may 
be absent altogether. If this is the case, use the MCID Elite channel linking feature to 
perform re-directed sampling from a counterstained tissue section. Re-directed sampling 
allows you to define regions of interest in one channel and gather data from the same 
coordinates in another. For example, you could load an image of a counterstained 
specimen into Channel 1 and its corresponding autoradiographic image (aligned with the 
counterstained specimen) into Channel 2.  To perform redirected sampling, use the Sample 
> Advanced > Channel Linking command to direct MCID Elite to report data values from 
Channel 2 only.  You then view Channel 1 and place your target outlines there using the 
counterstain to define anatomical boundaries.  MCID Elite replicates the target outlines 
from Channel 1 and reports density data from the autoradiograph in Channel 2.   

See the Advanced Details section for more information about re-directed sampling and 
aligning images. 

Step 5: Calibrating and Sampling Remaining Films/Plates 

A set of concentration standards should ideally be present on every sheet of film or 
phosphor plate used in the study. Re-calibration is necessary whenever you change films 
or load a different phosphor plate image. To establish a new density calibration, go to the 
Calibration operation window and click the [Re-calibrate] button. MCID Elite clears the 
existing calibration and is ready to receive a new one.  Repeat the procedure outlined in 
Step 3: Establishing a Density Calibration, above. 

Once you have established a new calibration curve, MCID Elite will convert the density 
value of each pixel that you subsequently sample to a value that corresponds to the new 
calibration.  Data gathered under previous density calibrations are unaffected. 

Step 6: Summarize and Save the Data 

MCID Elite contains a number of sophisticated data tracking, reporting and management 
facilities. If you label your targets as you gather data, you can create a variety of different 
data display formats that allow you to summarize data across and/or within Subjects, 
Sections and/or Regions. The MCID Elite imaging system’s data tracking capabilities can 
even show you where a given number comes from in an image. You can save data to disk 
as a proprietary, binary “log” file (*.lg2), or as standard text or spreadsheet files. 

It is beyond the scope of this Application Guide to present all MCID Elite data 
management features. A few particularly useful summary configuration and saving options 
are presented below, however. For a complete description, see the online Reference 
Manual (see Chapter 10: Data Management). 
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Summary Data Displays 
Two sets of controls are used to create data summaries. The first is a set of radio buttons 
underneath the Subject, Section and Region label indicators. The second is a set of four 
‘fly-out’ icons at the top right of the data table. Only one of these icons is visible at a time, 
and it is labeled as Select table. 

All Targets 
The default MCID Elite summary format is the Target Table. 

 
The Target Table is the most detailed form of data display, as it shows a discrete line of 
data for each individual target. By default, the MCID Elite data table lists only the data 
from the Current Subject, Current Section, and Current Region. To view all of the 
data you have gathered in one table, change the radio buttons to All Subjects, All 
Sections, All Regions. Every sample is subsequently displayed by its Subject, Section, 
Region and Target label (Figure 8). 

Figure 8: Part of a Target Table display showing data gathered from All Subjects, All 
Sections and All Regions. 

 

Subject x Region Summary Table 
Autoradiography data is frequently exported into statistics packages for analysis by 
Analysis of Variance. The preferred summary format is consequently a table that displays 
data from each individual subject by each individual anatomical region. 

You can display data in tabular format, with Subjects as rows, Regions as columns. To 
see the Subject x Region view, click on the Select table icon to see a fly-out icon bar.  
Select the Subject x Region icon.  

 
To pool data across all sections, select the All sections: Summary radio button. To 
display data within each section, select All sections: Detail. 



MCID Elite Application Guide  Quantitative Autoradiography  12 

01-MW-0191 Imaging Research Inc. 

Please note that MCID Elite can only display one measure at a time in this summary 
format.  MCID Elite displays the current measure above the Subject label indicator on 
the left side of the data table.  If you have made more than one type of measurement, 
double-click in this field to scroll to another measure (see Figure 9). 

Figure 9: A Subject x Region data summary.  Notice the Subject labels arranged in rows, 
Regions labels as columns.  MCID Elite can display one measure at time in this format. 

 

Saving Data 
MCID Elite stores data in a proprietary, binary “log” file format (*.lg2).  Log files contain 
more than just numerical data. They contain data, label lists, channel tracking information, 
and the calibration that was in effect when the file was saved. You can also save target 
outlines in log files.  

TO CREATE A LOG FILE: 
1. Go to the Sample window and open the File menu. 

2. Select the Save as option. The Save Data File dialog box appears (Figure 10). 

3. Type a filename into the entry field (e.g., Experiment 1). There is no need to type 
a file extension; MCID Elite always attaches the appropriate extension whenever 
it saves a file. 

4. Press the [Save] button. MCID Elite stores the file to disk under the specified 
filename. 

Figure 10: The Save Data File dialog box. 
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Re-Opening a Log File 
When you open a log file (File > Open), MCID Elite loads its data, labels (Subject, 
Section, Region), and the last density calibration.  This is almost like going back to the 
analysis session when you created the file.  You can edit data within the log file, create 
different data summary configurations, and add new data if you wish.  

Note: The calibration contained in the log file is the one that was in effect when you 
last saved the log file. MCID Elite saves calibrated data, but only the most 
recent calibration.  If you intend to continue sampling, we recommend you 
establish new calibrations. 

Saving Target Outlines 
To save target outlines with the log file, check the Target shape option in the Save Data 
File dialog box. With target outlines saved, you can click on any numerical value and see 
the target outline from which it came. 

Please note that target outlines are linked to channel coordinates, not to specific images. 
For this feature to be useful (i.e., to be able to re-display the target outline on the image 
from which it came), you have to be able to display both the sample window and the 
image associated with each numerical value. Images should consequently be saved to disk 
after they have been sampled. We recommend using the Subject and Section label entries 
as image filenames for easy indexing.  You want to be able to identify the image 
associated with each numerical data point. 

To see the origin of a data point, retrieve the log file that contains it.  Now load the image 
file that contains the data point that you wish to check.  When you click on the data point, 
the sample window saved with it appears on the image.   

Exporting Data 
The MCID Elite log file format (*.lg2) cannot be read by other programs. To format data 
for use with other software (e.g., word processing, spreadsheet, database programs), select 
the File > Export command.  A variety of text file formats are available, including tab 
delimited (*.txt), comma delimited (*.csv) and space delimited (*.prn).  Lotus® 1-2-3 
(*.wks) and Microsoft® Excel Workbook (*.xls) files can also be created.  Please note, to 
create *xls files from your data, Excel must be installed on the MCID Elite computer. 

File  > Export uses the WYSIWYG (what you see is what you get) principle.  Only the 
data in the current display will be exported, just as it appears on your monitor. You should 
consequently select all the data display options (e.g., within and across Regions, Sections, 
Subjects), and the summary options (e.g., Region or Target Summary table) before 
exporting your data.  
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Advanced Details 

Creating Standards Files 
Most laboratories use a limited number of standard sets as external references.   To avoid 
repetitive typing, you can save the values for each set and retrieve them when you need to 
calibrate. To create a standards file, either click on the [Create] button in the Open 
Density Standards File dialog box (Figure 2) or open the Establish menu and select Edit 
accessory file > Calibration standards.  This calls up a dialog box into which you can 
type the values of your standards, one per line (Figure 11). Enter the standards unit (e.g., 
fmol/mg) in the Standards unit entry field.  Then open the File menu in the dialog box 
and save the file.  The file is saved with an *.std extension.   

Note: This dialog box has no scroll bars.  Use the arrow keys to navigate up and 
down the list of standard values. 

Figure 11: Creating a file containing the values of external density standards. 

 

Background Subtraction 
For Density calibrations, you can use an unexposed part of the film or plate area as the 
background standard. This represents zero concentration, but the density standards also 
contain this background value and calibration should take care of the background 
contribution to standard values. 

If you prefer, MCID Elite can subtract a background value from each standard before 
calibration.  To do this, click on the Include background subtraction checkbox.  A 
Bkgd term appears in the Std Value column. Now sample a background region.  

When Density Data are Displayed in Red 
Occasionally, calibrated density data may be “flagged” in red.  This means that some of 
the pixels in the sample have density values that do not fall within the range of values 
established for the calibration curve.  Treat such data with caution.  Your decision to 
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accept or reject the data should depend on a) how many pixels are out of range, b) how far 
out of range they are, and c) what you’ve told MCID Elite to do with pixels that are out of 
range. 

To find out how many pixels are out of range, open the Sample menu and select Advanced 
> Density limits.  The Density Limit Calculation dialog box controls the display of data 
that is out of calibrated range.  Select the Report % checkbox and MCID Elite will report 
the proportion of out-of-range pixels in the sample.  The proportion is displayed in the 
data table, next to the flagged data. 

Figure 12: The Density Limit Calculation dialog box controls the display of data from 
samples that contain pixels that are out of range.  Such data is displayed in red. 

 

By default, MCID Elite will flag data when 1% or more of its pixels are out of calibrated 
range.  If you are willing to accept a higher percentage of out-of-range pixels in your 
samples, enter a higher Flag threshold.  For example, if you are willing to accept data 
from a sample with less than ten percent of its pixels out of range, enter a “10” in the Flag 
threshold entry field.  MCID Elite will then only flag data when 10% or more its pixels 
are out of range. 

By default, MCID Elite extrapolates calibrated values for pixels that are out of range.  A 
variety of extrapolation functions are available, and they can be applied to either end of 
the calibration curve.  Alternatively, MCID Elite can “clip” out-of-range pixels to the 
maximum or minimum standard value. For access to extrapolation options, go to the 
Calibration window and press the [Extrapolate] button displayed beneath the density 
calibration curve. 

Regardless of whether you choose to extrapolate or clip pixels that are out of range, be 
advised that these operations are meant to correct for minor excursions beyond the 
calibration curve. They should not be used as a correction for poor exposures.  

Re-Directed Sampling 
Re-directed sampling allows you to define regions of interest in one channel and gather 
data from the same coordinates in another (i.e., to define anatomical boundaries in a 
counterstained tissue section and gather data from the same its corresponding 
autoradiographic image). 
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TO ENABLE CHANNEL LINKING: 
1. Open the Sample menu and select Advanced > Channel linking. The Channel 

Linking dialog box will appear. 

2. Set the Channel Linkage Mode to Linked channel mode. 

3. The Channel checkboxes  (labeled “Ch 1” and “Ch 2” in Figure 13) indicate 
which channel(s) MCID Elite will gather data from. Put a checkmark in the 
channel containing the autoradiographic image, and select the measures(s) you 
wish to make. 

4. Click [OK] to exit the dialog box. 

Figure 13: The Channel Linking dialog box. 

 

TO PERFORM RE-DIRECTED SAMPLING: 
1. Digitize the autoradiographic image into “data” channel specified above. 

2. Align the counter-stained specimen with the autoradiographic image (see blow). 
Place the aligned image into another channel. 

3. Use any Sample tool to define anatomical boundaries in the counte-rstained 
section. 

4. MCID Elite automatically gathers data from the same coordinates in the 
autoradiographic image and reports the data in the data table. 

Aligning Images for Re-Directed Sampling 

TO ALIGN THE IMAGES: 
1. Digitize the autoradiographic section into Channel 1 (or whatever was designated 

as the “data” channel in the Channel Linking dialog box) 

2. Click the Alignment icon: 
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3. Two shadowy images are now visible, one on top of the other.  One is the 

autoradiographic section, which is “frozen” in place.  The other is a live image, 
which is actively digitizing.  The live image may be moved (by hand) into 
alignment with the stored image. 

4. Remove the film from the field of view. Move the counterstained section into the 
field of view and position it until it lies directly over the frozen autoradiographic 
image. If a density calibration is in effect, do not change the focus, camera height 
or illumination level! 

5. Press the [OK] button.  The autoradiographic image remains in Channel 1, and 
the aligned counterstained section is automatically placed into Channel 2. 

If you are working with phosphor plate images, it is still possible to perform re-directed 
sampling so long as you have a camera with which to digitize the tissue section. The 
procedure is a little cumbersome, given that the camera produces a smaller image than the 
phosphor imager and has a lower bit density. The trick is to get the images to match in 
terms of size, magnification level and bit density. 

TO ALIGN A SECTION WITH AN IMAGE FILE: 
1. Cut the phosphor image into smaller files (Image > Cut) that match the size of the 

camera output (e.g., 1280 x 1024 pixels). 

2. Set the display format (Settings > Display format) to the bit density that matches 
the camera. 

3. Retrieve a cut image file into Channel 1. Let MCID Elite convert the image file 
to a bit density that matches the display format. 

4. Click the Alignment icon: 

 
5. Two shadowy images are now visible, one on top of the other.  One is the image 

file, which is “frozen” in place.  The other is a live image, which is actively 
digitizing. 

6. Move the counterstained section into the field of view. Adjust the camera height 
and focus until the tissue section(s) is aligned with the section(s) in the image file. 

7. Press the [OK] button.  The cut image file image remains in Channel 1, and the 
aligned counterstained section is automatically placed into Channel 2. 

8. Save the aligned counter-stain image to disk. Use a filename that you can easily 
associate with the cut image filename. 

9. Repeat the procedure for all remaining cut images. The procedure is not as 
difficult now that the camera magnification matches the phosphor image. 
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TO PERFORM RE-DIRECTED SAMPLING: 
1. Enable the Channel linking feature as described above. 

2. Load a cut phosphor image file into the “data” channel. If necessary, change the 
display format to match the image bit density. 

3. Load the corresponding tissue image into any other channel. Let MCID Elite 
convert the image to a bit density that matches the display format (i.e., that of the 
phosphor image file). 

4. Use any Sample tool to define anatomical boundaries in the counter-stained tissue 
image. 

5. MCID Elite automatically gathers data from the same coordinates in the 
autoradiographic image and reports the data in the data table. 
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